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Introduction

This manual describes the printer and scanner functions of the e-STUDIO162/162D/151/151D MULTIFUNCTIONAL DIGITAL
SYSTEMS.

® For information on the following topics, please refer to the Operation Manual for the MULTIFUNCTIONAL DIGITAL SYSTEMS.
*Basic machine procedures (adding paper, replacing the toner cartridge, removing misfeeds, using peripheral devices)
* Copier functions
* Scanning from the operation panel of the machine
* Specifications
® \Where "e-STUDIOXXXX" appears in this manual, please substitute the name of your model for "XXXX".
® This manual refers to the Automatic Document Feeder as the "ADF", and the Reversible Automatic Document Feeder as the

"RADF".
® The screen images and procedures that appear in this manual are mainly for Windows XP. With other versions of Windows, some

screen images may be different from those in this manual.
® For information on using your operating system, refer to your operating system's manual or online Help.

Trademark Acknowledgments

* Microsoft® Windows® operating system is a trademark or copyright of Microsoft Corporation in the U.S.A. and other countries.

*\Windows® 98, Windows® Me, Windows NT® 4.0, Windows® 2000, and Windows® XP are trademarks or copyrights of Microsoft
Corporation in the U.S.A. and other countries.

e Acrobat® Reader Copyright® 1987- 2002 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo, Acrobat, and
the Acrobat logo are trademarks of Adobe Systems Incorporated.

e All other trademarks and copyrights are the property of their respective owners.

The display screens, messages, and key names shown in the manual may differ from those on the actual machine due to product
improvements and modifications.
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How to Use the Online Manual

This section explains how to view the online manual. Please read this section before using the online manual.

For information on using Acrobat Reader, see Acrobat Reader Help.

How to Control the Online Manual

In this manual, the following buttons are displayed at the
bottom of each page. Click these buttons to move quickly to
pages that you wish to view.

CONTENTS

Displays the Contents of this manual. Click on a topic in the
Contents to jump directly to that section.

INDEX

Displays the Index of this manual. Click on a topic in the Index
to jump directly to that section.

>

Takes you forward page by page.

<

Takes you back page by page.

Following Links

This manual uses a link function that allows you to jump to a
related page. If you click green, underlined text, the related
page will be displayed. (In the Contents and Index sections, the
linked areas are not underlined.)

Example: == Contents

To return to the previous page, click the « button on the menu
bar of Acrobat Reader.

Using Bookmarks

Bookmarks have been created on the left side of this manual.
You can click on a bookmark to jump directly to that section.

How to Print Out This Manual

To print this manual, select "Print" from the "File" menu of
Acrobat Reader. Select the desired printer settings in the "Print"
dialog box, and then click the "OK" button.

CONTENTS

INDEX
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1 ENTasic Printing

The following example explains how to print a document from WordPad.
Before printing, make sure that the correct size of paper for your document has been loaded in the machine.

Start WordPad and open the document that you 3 Make sure that "TOSHIBA e-STUDIOXXXX" is
wish to print. selected as the printer. If you need to change any
print settings, click the "Preferences™ button

Select "Print" from the application's "File" ("Properties" button in Windows 98/Me/NT 4.0) to
menu. open the printer driver setup screen.

The "Print" dialog box will appear. The printer driver setup screen will appear.

Document - WordPad
Edit  ‘iew Insert  For
e, .. Chrl+1

Open... Che+-O

S;f: Ct:I:S ftnc‘::tsmn Ready [ Print ta file '\

Save As.., Comment: Find Printer..
m Windows 2000 does not have the "Preferences" button

Prink Presiew

in this dialog box. Select settings as needed on each of
the tabs in the setup screen.
=" Printer Driver Settings, Printing Multiple Pages on One Page,
Fitting the Printed Image to the Paper,
Printing a Watermark, Two-sided Printing (Only for models that

support two-sided printing)

ﬂ Click the "Print" button ("OK" button in
Windows 98/Me/NT 4.0).
Printing begins. When printing begins, the Print Status
Window automatically opens.
(=Qutline of the Print Status Window)
The print job is delivered to the output tray, with the position of
the paper offset slightly from the previous job (offset function).
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PRINT
1 Basic Printing
If the tray runs out of paper during printing

Printing will automatically resume when paper is loaded in the
tray.

When using the bypass tray, select printer mode with the mode
select key on the machine, load paper as instructed by the
message in the display, and then press the [START] key to
resume printing.

When the 250-sheet paper feed unit is installed:
Note that if the "AUTO TRAY SWITCH" setting in the user
programs is enabled and there is the same size of paper in

another tray, the machine will automatically switch to the other
tray and continue printing.

Cancel a print job

Select printer mode with the [MODE SELECT] key on
the operation panel of the machine, and then press
the [CLEAR] key ((c)) or the [CLEAR ALL] key (@).

"CANCEL PRINT JOB?" will appear in the
display. Make sure that a checkmark appears in
front of "YES" and press the [ENTER] key.

When the machine is connected to your computer using
the USB 2.0 (Hi-Speed) ports on each, be sure to read
"System requirements for USB 2.0 (Hi-Speed mode)" in
the Operation Manual.

(M caution

CONTENTS INDEX

When "Paper Source" is set to "Auto Select”

If "Paper Source" is set to "Auto Select" in the "Paper" tab of the
printer driver setup screen and the correct size of paper for a
print job is not loaded in the machine, the printing procedure will
vary depending on the "FORCED OUTPUT" setting in the user
programs (see "USER PROGRAMS" in the Operation Manual).

When "FORCED OUTPUT" is set to "OFF"

Select printer mode with the mode select key on the machine,
check the message in the display, load paper in the bypass
tray, and then press the [START] key to begin printing.

When "FORCED OUTPUT" is set to "ON"

Printing takes place on the paper loaded in the machine, even
though the paper size is different from the print image size.




1 8Bening the Printer Driver From the "Start" Button

You can open the printer driver and change the printer driver settings from the Windows "start" button. Settings adjusted in this way
will be the initial settings when you print from an application. (If you change the settings from the printer driver setup screen at the
time of printing, the settings will revert to the initial settings when you quit the application.)

Windows 2000/XP Windows 98/Me/NT 4.0

Click the "start” button, and then click "Control Click the "Start" button, select "Settings" and
Panel". then click "Printers".
In Windows 2000, click the "Start" button and select "Settings".

E Click the "TOSHIBA e-STUDIOXXXX" printer

E Click "Printers and Other Hardware", and then driver icon and select "Properties” from the

click "Printers and Faxes". “File" menu.
In Windows 2000, click "Printers". LTE30E D FIOMCLE
Delete
- _ Rename
3 Click the "TOSHIBA e-STUDIOXXXX" printer | Fopetes |
driver icon and select "Properties" from the Close %
"File" menu. —
Create Shortcut In Windows NT 4.0, select "Document Defaults" to open
/ )
Delete the printer driver setup screen.
Renarne
Close In Windows 98/Me, click the "Setup" tab.

General IDetaiISI Sharingl Setup[’\t3

Click the "Printing Preferences" button in the
"General" tab. The printer driver setup screen will appear.

The printer driver setup screen will appear. = Printer Driver Settings
= Printer Driver Settings

CONTENTS INDE X Q]




PRINT

1

Printer Driver Settings

To view Help for a setting, click the [gd button in the upper right-hand corner of the window and then click the setting.
Some restrictions exist on the combinations of settings that can be selected in the printer driver setup screen. When a restriction is
in effect, an information icon ( (i) will appear next to the setting. Click the icon to view an explanation of the restriction.

& TOSHIBA e-STUDIOXXXX Printing Preferences

e] Main | Paper | Advanced | Watermarks |

Frequently used setting

_ S SPEe

Uszer Settings

LCopies:

h B

M-Up Printing

|—( 1

Dacument Style

@j@? @) sided
() P-Sided [Book]
Ok

| Facton Default w |

© ®

©@ ®

2-Sided [T ablet]

QL@ ok

i [ Cancel

Help

The above screen is the printer driver setup screen for
models that support two-sided printing.

The settings and the image of the machine will vary
depending on the model.

@ Note

F) TPEY

CONTENTS INDEX

@ Tab
The settings are grouped
on tabs. Click on a tab to
bring it to the front.

(2 Checkbox
Click on a checkbox to activate
or deactivate a function.

® Print setting image
This shows the effect of the
selected print settings.

@ Drop-down list
Allows you to make a selection
from a list of choices.

® Image of paper trays
The tray selected in "Paper
Selection" in the "Paper" tab
appears in blue. You can also
click on a tray to select it.

® Check button
Allows you to select one
item from a list of options.

@ "OK" button
Click this button to save
your settings and exit the
dialog box.

"Cancel" button
Click this button to exit the
dialog box without making any
changes to the settings.

@ "Apply" button
Click to save your settings
without closing the dialog box.

Windows NT 4.0

does not have the
"Apply" button.

The "Apply" button
does not appear when
you open this window
from an application.

"Help" button
Click this button to display the
help file for the printer driver.

< L




1 i;NrTinting Multiple Pages on One Page

This feature allows you to reduce and print two or four document pages on a single sheet of paper.
To use this function, open the printer driver setup screen and select "2-Up" or "4-Up" for "N-Up Printing" on the "Main" tab.

1="See Basic Printing for details on how to open the printer driver.
The "N-Up Printing" setting is not available when "Fit To Paper Size" is selected.

= Fitting the Printed Image to the Paper

N-Up H Border Border

M-p Printing
3 —
= K 20" CD Clp

arder A A |I

AB [AlB|
XXX "4-Up”
ADL CD |AD|

If you select the "Border" checkbox, borderlines will be printed around each page.

CONTENTS INDEX



1 Fﬁting the Printed Image to the Paper

The printer driver can adjust the size of the printed image to match the size of the paper loaded in the machine.

Follow the steps shown below to use this function. The explanation below assumes that you intend to print a letter size document on
invoice size paper.

15" See Basic Printing for details on how to open the printer driver.

The "Fit To Paper Size" setting is not available when "N-Up Printing" is selected.
= Printing Multiple Pages on One Page

Click the "Paper" tab in the printer driver setup n Select the actual size of paper to be used for

n screen. printing (Invoice).

The size of the printed image will be automatically

Select the original size (Letter) of the print adjusted to match the paper loaded in the machine.
image in "Paper Size". Paper Size: Letter

Paper Size Fit To Paper Size: Invoice

850 =110

Letter w

[ Cusgtom... ] — '
Check the "Fit to Page" box.

Fit To Paper Size Letter size dqcument Inyoice size paper
i_t to Page (Paper Size) (Fit To Paper Size)
Prifts Letter on If "A3 [Fit to Page]", "B4 [Fit to Page]", or "Ledger [Fit to Page]"

#Note

Irvaice W is selected, the printimage is fit to the letter size even if "Fit to

Page" is not selected.

CONTENTS INDE X <4 L 3




1 Two-sided Printing (Only for models that support two-sided printing)

The printer driver setup screen of models that support two-sided printing contains a "Document

Style" setting in the "Main" tab. This setting allows you to print on both sides of the paper. Document Style
To use this function, open the printer driver setup screen and select "2-Sided (Book)" or () 1-Sided
"2-Sided (Tablet)" from "Document Style" in the "Main" tab. (%) 2-5ided [Book]
="See Basic Printing for details on how to open the printer driver. () 2-Sided [T ablet]

® Paper sizes that can be used for two-sided printing are Letter, Legal, Folio*, Invoice, A4, A5, B5, Foolscap, and 16K.
® \When using two-sided printing, select a source other than "Bypass Tray" for the "Paper Source" in the "Paper" tab.
* For two-sided printing on Folio size paper, "Tray 1" or "Tray 2" (if Tray 2 has been installed) must be selected in the "Paper
Source" on the "Paper" tab.

The following example shows the result when portrait data is printed on both sides of the paper.

Printing result
2-Sided (Book) 2-Sided (Tablet)

Print data

The pages are printed so that The pages are printed so that
they can be bound at the side. | they can be bound at the top.

CONTENTS INDEX



1 iRRmz)tating the Print Image 180 Degrees

The print image can be rotated 180 degrees.

This feature is used to enable correct printing on envelopes and other paper with flaps that can
only be loaded in one orientation. O Partrai
To use the feature, select the image orientation in "Image Orientation" on the "Paper" tab, and ® Landscape

then select the "Rotate 180 degrees" checkbox. Dtate 180 degrees

Image Orientation

1="See Basic Printing for details on how to open the printer driver.

Printing result

Rotate 180 degrees H Rotate 180 degrees

aogyv ABCD
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1 igNlT'inting a Watermark

You can print a watermark such as "CONFIDENTIAL" on your document. To print a watermark, open the printer driver, click the
"Watermarks" tab, and follow the steps below.

See Basic Printing for details on how to open the printer driver.

How to Print a Watermark

From the "Watermark" drop-down list, select the watermark that you wish to print (for example "CONFIDENTIAL"), and start printing.

W atermark:

[Mane) w

W atermark:
[Mane)
TOF SECRET

DRAFT Eg

ORIGINAL
COFY

COMFIDEMTIAL

Print sample

You can enter text to create your own custom watermark. For details on watermark settings, view printer driver Help.
= Printer Driver Settings

CONTENTS INDEX




1 P(%tline of the Print Status Window

When printing begins, the Print Status Window automatically opens.
The Print Status Window is a utility that monitors the machine and shows the name of the document being printed and any error

messages that occur.

When the machine is used as a network printer, the Print Status Window will not function.

®

& TOSHIBA e-STUDIOXXXX Print Status Window [= |[T1|[5¢]

@—‘ Frint b aritar letiDns ]
Docurnent Mame: *
O,

Q@@
"

, ......... |:||:|SE‘| Help ‘

CONTENTS INDEX

(@ Status window
Provides information on the

current status of the printer.

(2 Status icon
The status icons appear to
alert you to printer errors.
Nothing appears when printing
is taking place normally.
The icons are explained
below. Follow the
instructions in the status

window to solve the problem.

An error has
occurred that
requires immediate
attention.

An error has
occurred that
requires attention
soon.

Q
N

® Tab
Click a tab to bring it to the
front. The "Options" tab
allows you to select display
options for the Print Status
Window.

@ Document Name
Shows the name of the
document currently being
printed.

® "Cancel Job" button
Printing can be canceled by
clicking this button before the
machine receives the job.

® "Help" button
Click this button to display
the help file for the Print
Status Window.

@ "Close" button
Click this button to close
the Print Status Window.

< 4B




2 Sharing the Printer Using Windows Networking

The machine can be used as a shared printer in a Windows 98/Me/NT 4.0/2000/XP network environment.
Note that the Windows network environment must already be established.

Client Print server Shared printer

Client Client

"Print server" as explained here is a computer that is directly connected to the machine, and a "Client" is any other computer that is
connected to the same network.

i Shared Printer Settings , _
(On the print server) w=Client Settings

CONTENTS INDEX



On the computer to which the machine is directly connected

Follow the steps below to use the computer directly connected to the machine as a print server.
If your operating system is Windows 98/Me, start from step 1. If your operating system is Windows NT 4.0, 2000 or XP Home

Edition, open the control panel and then start from step 6.

If your operating system is Windows XP Professional, refer to the Operation Manual or the help file of your operating system.

Click the "Start" button, select "Settings", and
then click "Control Panel"”.

E Double-click the "Network" icon (23).

If the "Network" icon does not appear in Windows Me,
@ Note C o . "
click "view all Control Panel options".

E Click the "File and Print Sharing" button.

Enable "l want to be able to allow others to print
to my printer(s).” by clicking the checkbox, and
then click the "OK" button.

E Click the "OK" button in the "Network" dialog
box.

7 If a message appears asking you to restart the
computer, click the "Yes" button and restart the

computer. Then, open the printer folder and continue the
setup procedures from Step 6.

Click "Printers and Other Hardware" in the
control panel, and click "Printers and Faxes".
In operating systems other than Windows XP,
double-click the printer icon.

driver icon and select "Sharing" from the "File"
menu.

Establish the settings for sharing, and click the
"OK" button.

Click the "TOSHIBA e-STUDIOXXXX" printer

For information on a setting, click the [z] button at the
7 o%e top-right of the dialog box and then click the setting to

display Help.

=" Client Settings

<} 16 |



2 Emi;ZHr;RItNGSettings

Follow the procedure below to install the printer driver in the client.

This page provides steps for Windows XP Home Edition users only. If your operating system is Windows 98/Me/2000/XP
#Note » . . .
Professional, refer to the Operation Manual or the help file of your operating system.
If your operating system is Windows NT 4.0, refer to "Settings in Windows NT 4.0".

n Click the "start" button, and click "Control n Click the "Next" button.
Panel".

Add Printer Wizard

Welcome to the Add Printer
E Click "Printers and Other Hardware", and click Wizard

(1] P ri n te rs a n d Faxes [T} . This wizard helps you install & printer ar make printer

connections.

|F you have a Plug and Play printer that connects
1 thraugh a USE port [or any other hot pluggable
port, such as IEEE 1394, infrared. and so on). you
do not need to use this wizard, Click Cancel to
cloge the wizard, and then plug the printer's cable
inta your camputer o point the printer tovward your
computer's infrared part, and turn the printer on,
‘Windaws will automatically install the printer for pau.

3 Click "Add a printer" in "Printer Tasks".
The "Add Printer Wizard" will appear.

To continue, click Mext.

" Printers and Faxes

File Edit View Favorites Tools  Help

@Back = J l.@ /':j Search lL. Folders v

Printer Tasks
@ Ad%[a printer
&5 Seth_JFaxing

See Also £
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PRINTER SHARING

Client Settings

Select "A network printer, or a printer attached 7 Select the printer to be shared in the network,
to another computer”, and click the "Next" and click the "Next" button.

button.
Add Printer Wizard
Add Printer Wizard Browse for Printer O
“when the list of printers appears, select the ane you want o uze. Q’

Local or Network Printer

The wizard needs to know which type of printer to set up, v

Printer, |\\TDSHIBA02\TDSH\BA e STUDIDR

Shared printers

Select the option that describes the printer you want to use:

) Local printer attached to this computer

Automatically detect and install my Plug and Play printer

%ﬁ netwerk printer, or 3 printer attached to another computer

2 1 Tosetup anetwork printer that i not attached to a print server, Comment:
'\l-") use the “"Local printer option Status: Diocuments waiting; a

[ < Back ” Mext » J[ Cancel ]

< Back ” Hest » I[ Cancel ]

The contents of this window will vary depending on your
network environment.

Select "Browse for a printer", and click the
"Next" button. Select settings in the "Default Printer" screen,

and click the "Next" button.

Specily a Printer 5
It you don't knowe the name o address of the printer, you can search far a printer Q’/

Click the "Finish" button.

What printer da you want to connect to?

géé}éﬁs'é for & prinker
Tannect to this printer [or to browse for a printer. select this option and click Mext):

Nare: | |

Example: W\zerveriprinter

() Connect to a printer on the Internet or on a home or office network:

URL: | |

Example: hitp://server/printers/myprinter. printer

< Back ” ext > I[ Cahcel ]

CONTENTS INDE X Q] |>




2 Client Settings
Settings in Windows NT 4.0

If your operating system is Windows NT 4.0, establish settings as follows in the printer properties after installing the printer driver.
For the procedure for installing the printer driver, see "INSTALLING THE SOFTWARE" in the Operation Manual (for Basic Function).

n Click the "Start" button, select "Settings", and n Select "Local Port" in the "Available Printer
then click "Printers". Ports" list, and click the "New Port" button.
The "Port Name" dialog box will appear.
Click the "TOSHIBA e-STUDIOXXXX" printer S
driver icon and select "Properties" from the by
"File" menu. et D Moot P

k TCPAP Metwark Port

The printer properties will appear.

Click the "Ports" tab, and click the "Add Port"

Cancel
button. —
The "Printer Ports" dialog box will appear.
Enter "\\(name of server connected to
e e machine)\(name of shared printer)"”, and click
@ TOSHIBA &-5TUDIDGN the "OK" button-
Print to the following port(s]. Dacuments will print ta the first hee:
Name of server connected
: Egg:c:”ggan : ?gn;:'mmsmo‘.“ = to machine Enter .| part name:
B LocatFn [WTOSHIBAN-STUDIONS, Cancel |
B Lot | Name of shared printer Hep_|
[ FILE: Local Part ;I
AddPat.. | Delete Port Configue Port.. |
I eoamamy Click the "Close" button in the "Printer Ports"
dialog box.
7 Click the "OK" button in the printer properties
window.
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3 Scanning Overview

The flow chart shown below provides an overview of scanning.

(Dcaution  The scanning function can only be used when your computer is connected to the machine by a USB cable.

Scanning from a TWAIN*1-compliant Scanning from the "Scanner and : ; : -
or WIA*2-compliant application ‘I: Camera Wizard" (Windows XP) ! Using the machine to begin scanning™
1s 1,

Place the original in the scanning position
="For more information, refer to "NORMAL COPYING" in the Operation Manual.

Start up a Twain-compliant or
WIA-compliant application, and
select the machine's scanner

Start up the "Scanner and
Camera Wizard" from "Control
Panel" in your computer.

Change the machine to scanner
mode and select the scan menu.
(SC1: to SC6:)

1
1
1
1
1
1
1
1
1
1
1
: Set the scan preferences !
: (only if the preferences are set to appear) .
1
1
1
1
1
1
1
1
1
1

Scanning
Iz"Scanning from a
TWAIN-Compliant Application,
Scanning from a WIA-Compliant
Application (Windows XP)

Scanning
' | iI"Scanning from the "Scanner and
I Camera Wizard" (Windows XP)

Scanning

in the Operation Manual,
Outline of Button Manager

- aes or eor or or e or or e or ar e ED G ED ED G D ED G D ED ED a e e ey

1
1
1
1
1
1
1 [ ="USING THE SCANNER MODE"
1
1
1
1
1
1

*1 TWAIN is an international interface standard for scanners and other image acquisition devices. By installing a TWAIN driver on your computer, you can
scan and work with images using a variety of TWAIN-compliant applications.

*2 WIA (Windows Imaging Acquisition) is a Windows function that allows a scanner, digital camera or other imaging device to communicate with an image
processing application. The WIA driver for this machine can only be used in Windows XP.

*3 To scan using the machine's operation panel, you must first install Button Manager and establish the appropriate settings in the Control Panel. For details,
see "SETTING UP BUTTON MANAGER" in the Operation Manual.

CONTENTS INDEX



3 SS(:ENanning from a TWAIN-Compliant Application  (part 1)

The TOSHIBA scanner driver is compatible with the TWAIN standard, allowing it to be used with a variety of TWAIN-compliant
applications. Below is a step-by-step guide for acquiring a scanned image to the Desktop Document Manager desktop screen using

Desktop Document Manager.

Place the original(s) that you wish to scan on 3 Select "TOSHIBA e-STUDIO TWAIN E", and click
the document glass/ADF/RADF. the "Select" button.

=’ For information on setting an original for scanning,
refer to "NORMAL COPYING" in the Operation Salect Sourca
Manual. TOSHIEA e-5TUDID TWAINE

Start Desktop Document Manager and then click
the "File" menu and select "Select Scanner".

® |f you are using Windows XP, you can also select
o) "WIA-TOSHIBA e-STUDIOXXXX" to scan using the

% Desktop Document Manager
Edit “iew Tools Internet Help

Mew Folder kM WIA driver.
=" Scanning from a WIA-Compliant Application
(Windows XP)
® Depending on your system, "TOSHIBA e-STUDIO
Acoire Tmage... TWAIN E 1.0 (32-32)" and "WIA-TOSHIBA
EECETITR e-STUDIOXXXX 1.0 (32-32)" may appear in the above

"Select Source" screen.

The method for accessing "Select Scanner" depends
o upon the application. For more information, refer to the

manual or the help file of your application.
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Click the "Preview" button.
The preview image will appear.

Select "Acquire Image" from the "File" menu, or

3 Scanning from a TWAIN-Compliant Application  (part 2)
click the "Acquire" button (/=.).

The scanner driver setup screen will appear. : :
=S Dri Setti P Note e |f the angle of the image is not correct, reset the
canner Uriver oetlings original, and click the "Preview" button again.

E In the "Scanning Position" menu, select the e |f the preview image is not oriented correctly, click the

location where you placed the original in Step 1. Rot_ate _button in the preview screen. This r_otates the
. . preview image 90 degrees clockwise, allowing you to
¢|f you placed a one-sided original in the ADF/RADF, . . . . °
i . N correct the orientation without resetting the original.
select "ADF (Simplex)". = _
When using the RADF: Proview scroo” _
e|f you placed a two-sided original in the RADF, select ® If you set multiple pages in the ADF/RADF, the
"ADF (Duplex-Book)" or "ADF (Duplex-Tablet)" machine previews only the top page of the originals,

according to the binding position of the original and then sends it to the original exit area. Return the
' previewed original to the ADF/RADF before starting

If you selected "ADF (DupIex—!Book)" or "ADF the scanning job.
(Duplex-Tablet)" in the "Scanning Position" menu, select
whether the orientation of the placed original is "Right
Edge Fed First" or "Leading Edge Fed First".

TOSHIBA e-STUDIOX XXX

v
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3 SS(‘:ENanning from a TWAIN-Compliant Application  (part 3)

Specify the scanning area and set the scan
preferences.

For information on specifying the scan area and setting
the scan preferences, see scanner driver Help.

=" Scanner Driver Settings

Scanning a large area in full color at high resolution
results in a large quantity of data and a prolonged
scanning time. It is recommended that you set
appropriate scanning preferences for the type of original
being scanned, i.e., Web page (monitor), Photo, FAX, or
OCR.

(D Caution

When you are ready to begin scanning, click the
"Scan" button.

To cancel a scanning job after clicking the "Scan"
button, press the [Esc] key on your keyboard.

When you close the scanner driver after scanning, the
image data will appear as a new file in Desktop
Document Manager, as shown below.

%% Desktop Document Manager

File Edit Wew Tools Internet Help
B 2 & EY
Cpen Acquire Copy Paste Compaoser Imaging Arrange Explorer
EI& Deskbop Docurment
5 Articles
- CEils
I Expense Reports
2 Important Documents .
) Receipts i%i
|7 Statements Mail
{EJ Iy Documents
[# i My Computer
Conver £ By
QR
Y
=
Composer
application
Ready MM él
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SCAN

Scanning from a TWAIN-Compliant Application

Scanner Driver Settings

The scanner driver setup screen consists of the "Set-up screen", which lets you select scan settings, and the "Preview screen",
which shows the scanned image. For details on the scan settings, click the "Help" button in the preview screen to display Help.

Set-up

‘ : )—EScagning Pozition :

@—1e,; .

screen

|F'Iaten

~

Scanning Mode :

=

|F'reset

wieh Pages

Fresets for Image Type and Resolution:

Phata

ABCD

—_—
ABCODEFGH
MOPGRETU

@)  Preview #

Sean |

Cloze |

@??@

CON

TENTS

(@ "Scanning Position" menu
Select the location where the original is
placed. Selections are "Platen" (document
glass), "ADF (Simplex)", "ADF
(Duplex-Book)" or "ADF (Duplex-Tablet)".
iz Scanning from a TWAIN-Compliant

Application

@ Scan side menu (Only appears if
the machine has an RADF)
If you placed a two-sided original in the RADF,
select "Right Edge Fed First" or "Leading Edge
Fed First" from the scan side menu according
to the orientation of the placed original.

@ "Scanning Mode" menu
Select "Preset" or "Custom Settings"
for the scanning mode. For details on
the settings, click the "Help" button in
the preview screen to display Help.

@ "Zoom Preview" Checkbox

When this is selected, the selected part of
the preview image will be enlarged when
the "Preview" button is clicked. To return to
the regular view, remove the checkmark.

"Zoom Preview" cannot be used
when "ADF" is selected in the
"Scanning Position" menu.

INDEX

(part 4)

® "Preview" button
Previews the document.

If "Preview" is canceled by
immediately pressing the [Esc]
key on your keyboard, or the
[CLEAR] key ((c]) or [CLEAR
ALL] key (») on the machine,
nothing will appear in the
preview screen.

® "Scan" button
Click to scan an original using the selected
settings. Before clicking the "Scan" button,
make sure the settings are correct.

To cancel a scanning job after
clicking the "Scan" button, press
the [Esc] key on your keyboard,
or the [CLEAR] key ((c]) or
[CLEAR ALL] key ((») on the
machine.

@ "Close" button
Click to close the scanner driver setup screen.

<[
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3

Preview screen

TOSHIBA e-STUDIO XXX

O,

L l Rotate |
Image Size |

: Full Color
. 7hdpi
- 191 MBE

Color Mode
Fiezolution
Size

@ Preview window
Click the "Preview" button in the Set-up screen to display the
scanned image. You can specify the scanning area by
dragging the mouse inside the window. The inside of the
frame that is created when you drag the mouse will be the
scanning area. To cancel a specified scanning area and
clear the frame, click anywhere outside the frame.

CONTENTS INDEX

Scanning from a TWAIN-Compliant Application

(part 5)

2 "Rotate" button
Click to rotate the preview image 90 degrees clockwise. This
allows the orientation to be corrected without resetting the
original. Upon scanning, the image file is created in the
orientation shown in the preview window.

@ "Image Size" button
Click to open a dialog box that allows you to specify the
scanning area by entering numbers. Pixels, mm, or inches
can be selected for the units of the numbers. By initially
specifying a scanning area, numbers can be entered to
change that area relative to the top left corner as a fixed
origin.

@ "Auto Scan Area Adjustment” button
Click when the preview screen is displayed to automatically
set the scanning area to the entire preview image.

>

—— Click the "Auto Scan Area Adjustment"” button
to automatically set the scanning area to the
entire preview image.

-— Preview image

— Preview window

® "Help" button
Click to display the help file for the scanner driver.

<25




3 sS(:é\;mning from a WIA-Compliant Application (Windows XP)  (part 1)

If you are using Windows XP, you can use the WIA driver to scan from Desktop Document Manager, Paint and other WIA-compliant
applications. The procedure for scanning using Paint is explained in the following.

Place the original that you wish to scan on the P Note If you have Wb?:drivers for ch"er devices.installed in your
document glass/ADF/RADF. computer, the "Select Device" screen will open. Select

"TOSHIBA e-STUDIOXXXX" and click the "OK" button.

=" For information on setting an original for scanning,
refer to "NORMAL COPYING" in the Operation

=% Select Device

Manual.
Which device do you want to use?
Start Paint and then click the "File” menu and ® >
select "From Scanner or Camera". Rl Rl TosHIon
The scan screen of the WIA driver will appear.

i untitled - Paint Marufacturer.  TOSHIBA
l= Edit ‘“iew Image Colors Help Description: TOSHIBA e-STUDIDMN:
e Chrl+M
Open... O [ i [ B J
Save Chrl+5

Save As...

From Scanner or Camera,..

Print Preview

Page Setup...
Print... Ctrl+P
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3 séc:é\;mning from a WIA-Compliant Application (Windows XP)  (part 2)

Select the paper source and picture type, and 2 e |f you select "Document Feeder" for the "Paper source"
click the "FI’)re?Iiew" button. P yp and click the "Preview" button, the top original in the

The preview image will appear. ADF/RADF is' previevyed. The previewed original is
sent to the original exit area, so you will need to return

If you placed the original on the document glass, select 15 e AR DI st e e seamie
"Flatbed" for the "Paper source". : : ) - : i
o i ® To view Help for a setting, click the button in the
'I'f you placed the or'!glnal In 't'he ADF/RAD':’ select _ upper right-hand corner of the window and then click
Document Feeder" for the "Paper source" and specify the setting.
the original size in "Page size".
= Scan using TOSHIBA e-STUDIOXXXX 7)) Click the "Scan" button.
What do you wantto scan? | B L Scanning begins and the image is acquired into Paint.
j Use "Save" in your application to specify a file name
ol e oo aoon : : and folder for the scanned image, and save the image.
e To cancel a scanning job after clicking the "Scan"
Dl | § button, click the "Cancel" button.
() Grayzcale picture : :
() Black and white picture or test :
() Custom Settings E
r'ou can alzo: I
Adjust the guality of the scanned picture -
----------------------------
[ Preview ] [ Scan ] [ Cancel ]

CONTENTS INDE X <4 L 3




3 sé?gnning from the "Scanner and Camera Wizard" (Windows XP)  (part 1)

The procedure for scanning with the "Scanner and Camera Wizard" in Windows XP is explained here. The "Scanner and Camera
Wizard" lets you scan an image without using a WIA-compliant application.

Place the original that you wish to scan on the Click the "Next" button.
document glass/ADF/RADF.
= Scanner and Camera Wizard g|

=" For information on setting an original for scanning,
refer to "NORMAL COPYING" in the Operation
Manual.

Welcome to the Scanner and Camera
Wizard

TOSHIEA e-STUDION-X

Click the "start" button, click "Control Panel",
click "Printers and Other Hardware", and then
click "Scanners and Cameras".

This wizard helps pou copy pictures from your camera, scanner, or other
device to your computer, your network, or the Web.

3 Click the "TOSHIBA e-STUDIOXXXX" icon and
then click "Get pictures” in "Imaging Tasks".
The "Scanner and Camera Wizard" will appear.

% Scanners and Cameras To continue, click Mest.

File

Edit Yiew Favorites Tools  Help

3 B =» ) !? j_\Search |f - Folders v Back |. Mewt > QJ [ Cancel

Imaging Tasks
&’ Geéfictures
Vieh_device properties

Other Places

*

@ control Pansl
[} My Documents
| Shared Documents
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3 sé?gnning from the "Scanner and Camera Wizard" (Windows XP)  (part 2)

Select the "Picture type" and "Paper source", 2 e |f you select "Document Feeder" for the "Paper source"
and click the "Next"ybputton. P and click the "Preview" button, the top original in the

If you placed the original on the document glass, select ADF/RADF is previewed. The previewed original is
"Flatbed" for the "Paper source". sent to the original exit area, so you will need to return

If you placed the original in the ADF/RADF, select it to the ADF/RADF before starting the scanning job.

o . : . :
"Document Feeder" for the "Paper source" and specify UL the_ resolupon, p'fture type, br.'ghtf,'ess il

.. N . contrast settings, click the "Custom settings" button.
the original size in "Page size".

You can click the "Preview" button to display the

preview image. Specify a group name, format and folder for saving
the image, and then click the "Next" button.

= Scanner, and Camera Wizard [Zl

Choose Scaning Preferences o JPG, BMP, TIF or PNG can be selected for the format.
&I;Ug‘scfu_\::.u scanning preferences, and then click Preview to see how your preferences affect i To beg i n Scan n i ng ’ CI i Ck th e " N ext" b utton .

= Scanner and Camera Wizard ['X‘

Picture Name and Destination T
Select a name and destination for pour pictures, [4

2. Select afile format

[[£) 4PG WPEG Image) v

Flatbed w | E E 3. Choose a place to save this group of pictures:

My Pictures'Picture v Browse
=] I

[ < Back ” ﬂexb[x][ Cancel

¢ Back ” Hexn[\][ Cancel
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SCAN
1 n - n -
3 Scanning from the "Scanner and Camera Wizard" (Windows XP)  (part 3)
7 When scanning ends, the following screen will E Click the "Finish" button.
appear. Select the next task that you wish to The "Scanner and Camera Wizard" closes and the
perform, and then click the "Next" button. scanned image is saved in the specified folder.

If you are ready to end the session, click "Nothing. I'm
finished working with these pictures".

= Scanner and Camera Wizard rz‘

Completing the Scanner and Camera
Wizard

=+ Scanner and Camera Wizard er

Other Dptions D”
“fou can choose to keep working with vour pictures. [

1 picture(s] were copied.

Ta see pour pictures on vour computer or network, click the location
below

. . My Pictures\Picture
Your pictures have been successfully copied to pour computer or network.

You can also publish these pictures to aWeb site or order prints online.

‘What do you want to do?

() Publigh these pictures to a'web cite
(O Order prints of these pictures from a phota printing ' eb site

() Nothing, I'm finished working with these pictures

Lear more about working with pictures.

Ta close this wizard and see your pictures, click Finish,

¢Back |f Finishv@[ Cancel

< Back ” ﬂexb[\l[ Cancel
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Outline of Button Manager

Button Manager is a software utility that allows you to use the scanner function at the machine. Button Manager allows you to

configure six sets of scanning settings as a scan menu on the machine.

To view Help for a setting, click the gd button in the upper right-hand corner of the window and then click the setting.

15 To begin scanning using the machine's operation panel, settings must be established in the Control Panel after Button Manager is
installed. For information on installing Button Manager and establishing the Control Panel settings, see "SETTING UP BUTTON

MANAGER" in the Operation Manual. For information on scanning using the machine's operation panel, see "USING THE
SCANNER MODE" in the Operation Manual.

12 Scan Button Destination Settings

| Egp cation Selection
Jeskkop Document Manager

(F Show TWAIM sefting screen when scanning)

Deskkop Document Manager

File Format | TIFF 2

Scan Setup
Colar Mode | Full Color = |

Edge |N0ne

-

Image Area | Letter

Resolution | 7a

LCalor Matching | Far CRT

Ledlef Lol LefLel

Menu Name |

—e

‘ ak | Cancel | | Help

@900 © © ©C

@ Tab
Click to set scan menu
options. Each tab contains
scan settings for the scan
menu.

@ "Application Selection" area
Select the start-up
application here.

@ "Show TWAIN setting
screen when scanning”
Checkbox
You can select whether or not
the TWAIN screen is shown.
When the checkbox is
selected, the TWAIN screen
appears when scanning is
executed to let you adjust the
scanning conditions.

@ "Scan Setup" area
Set the scan conditions.

Some applications
may limit your choice
of settings.

® "Menu Name" button
Set the menu names that
appear in the machine display.
These will also be the tab
names of this setting screen.

® "OK" button
Click to save your settings
and exit the dialog box.
@ "Cancel" button
Click this button to exit the
dialog box without making
any changes to the settings.
"Apply" button
Click to save your settings
without closing the dialog box.
© "Help" button
Click this button to display the
help file for Button Manager.

You can use Button Manager to select and change the functions of the six scan menus. Refer to Button Manager Settings.

CONTENTS
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3 SICBANutton Manager Settings

Once installed, Button Manager normally runs in the background in the Windows operating system. If you need to change Button

Manager settings, follow the steps below.

For details on Button Manager settings, see Button Manager Help.

=’Qutline of Button Manager

n Right-click the Button Manager icon (i) on the
task bar, and select "Settings" from the pop-up
menu.
The setting screen of Button Manager will open.

Show Version..,

)

Clase

If the Button Manager icon does not appear on the task
bar, click the "start" button, select "All Programs"
("Programs" in Windows 98/Me/2000), select "TOSHIBA
Button Manager E", and then click "Button Manager" to
start Button Manager.

#Note

Select the start-up application in the
"Application Selection™ area.

7 ® \When the "Show TWAIN setting screen when
scanning" checkbox is selected, the scan setting

screen appears when scanning is executed to let you
adjust the scanning conditions.

® \When you scan the two-sided originals in the RADF,
only one sided scan can be performed.

® On the applications other than "FAX", the format can
be selected in "File Format". The image quality of
JPEG format (only can be selected on "Desktop
Document Manager" and "Email") is not as high as the
other formats.

Button Manager scan menu (factory default)

Click the tab of the scan menu that you want to
set up.

SCt: |scz | sca | sca | scs | sce |

CONTENTS INDEX

SC1: Desktop Document Manager
SC2: Email

SCa: FAX

SC4: OCR

SC5: Microsoft Word

SC6: Filing
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3 SICBANutton Manager Settings
4

Set up the "Color Mode", "Edge" and other scan
settings in the "Scan Setup" area.

The tab names are initially "SC1:" to "SC6:". To assign a name to
a tab, click the "Menu Name" button and enter the desired name.
After entering the name, click the "Apply" button or the
"OK" button in the setting screen. The assigned names will
appear in the machine display when you select a scan
menu at the machine. (Example: SC1:xxxxx)

If a character that the machine cannot display is entered
in the "Menu Name", "?" is displayed on the machine.

Click the "OK" button.
This completes the settings.

CONTENTS INDEX



’ TROUBLESHOOTING
If you experience difficulty using the machine, check the following troubleshooting guide before calling for service.

Many problems can be easily resolved by the user. If you are unable to solve the problem using the troubleshooting guide, turn off
the power switch and unplug the machine, and contact your service technician.

PRINTING AND SCANNING PROBLEMS

In addition to this section, troubleshooting information can also be found in the README files for each of the software programs. The
README file (readme.txt) is copied to your computer when the software is installed, and can be found in the "Program Files" -
"TOSHIBA" - "eS151162" folder on the drive where you installed the software.

Problem Cause and solution Page
The machine is not correctly connected to your computer. Operation
— Check both ends of the USB cable or Parallel cable and make sure you have a solid I\?Ianual

connection. Try a known good cable.

If the machine is used as a shared printer, the name of the computer to which the
The machine does not print. machine is connected or the share settings have changed. -
— Reconfigure the port setting of the shared printer.

The machine is not selected in the application.
— After choosing "Print" from the "File" menu, make sure that "TOSHIBA -
e-STUDIOXXXX" is selected as the printer in the "Print" window.

CONTENTS INDEX



4 Troubleshooting

Problem

The machine does not print.

Cause and solution

The printer driver has not been installed properly.
— Follow these steps to check and see if the printer driver is installed.
1 Click the "start" button, click "Control Panel", click "Printers and Other Hardware",
and then click "Printers and Faxes".
(On Windows 98/Me/NT 4.0/2000, click the "Start" button, select "Settings" and
then click "Printers".)
2 Does the "TOSHIBA e-STUDIOXXXX" printer driver icon appear?
3 If the icon is shown but you still cannot print, the printer driver may not have been
installed correctly.
In this case, delete "TOSHIBA e-STUDIO151/151D/162/162D Series MFP Driver"
and then reinstall it.

Operation
Manual

A copy job is in progress.
— Wait until the copy job is finished.

The size of paper loaded in the tray is different from the paper size setting in the

machine.

— Make sure that the size of paper loaded in the tray and the machine's paper size
setting agree.

Operation
Manual

The specified size of paper has not been loaded.
— Load the specified size of paper in the paper tray.

Operation
Manual

The "FORCED OUTPUT" setting is set to "OFF".

— When "FORCED OUTPUT" is set to "OFF" and there is no paper in the machine that
is the same size as the printimage, load paper in the bypass tray as instructed by the
message in the display and press the [START] key to begin printing. (The bypass tray
cannot be used for two-sided printing.) If "FORCED OUTPUT" is set to "ON", the job
will be printed on the paper in the machine even though it is a different size.
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4 Troubleshooting

Problem

Printing is slow.

Cause and solution

Simultaneous use of two or more application software programs.
— Start printing after quitting all unused application software programs.

The paper is loaded so that printing takes place on the back side of the paper.

The printed image is dirty.

The printed image is light and — Some paper types have a front and back side. If the paper is loaded so that printing | Operation
uneven. takes place on the back side, toner will not adhere well to the paper and a good image Manual
will not be obtained.
You are using paper that is outside the specified size and weight range. Operation
— Use copy paper within the specified range. Manual

Paper is curled or damp.

— Do not use curled or crimped paper. Replace with dry copy paper. During periods
when the machine is not used for a long time, remove the paper from the tray and
store it in a dark place in a bag to prevent moisture absorption.

You did not set sufficient margins in the paper settings of your application.

— The top and bottom of the paper may be dirty if the margins are set outside of the
specified print quality area.

— Set the margins in the software application within the specified print quality area.

The printed image is skewed or it
runs off the paper.

The size of paper loaded in the tray is not the size specified in the printer driver.

— Check if the "Paper Size" options suit the size of paper loaded in the tray.

— If the "Fit to Page" setting is activated, make sure that the paper size selected from
the drop-down list of the "Fit To Paper Size" option is the same as the size of the
loaded paper.

CONTENTS INDEX




4 Troubleshooting

Problem

The printed image is skewed or it
runs off the paper.

Cause and solution

The orientation of document setting is not correct.
— Click the "Paper" tab in the printer driver setup screen, and verify if the "Image
Orientation" option is set to your requirements.

Paper is not loaded properly.
— Make sure the paper is properly loaded.

You did not correctly specify the margins in the application.

— Check the layout of the document margins and the paper size settings in the
application you are using. Also check if the print settings are specified correctly to suit
the paper size.

Poor scanning quality.

Error indicator is lit or blinkin See "DISPLAY MESSAGES" to check the meaning of the error indicator and error | Operation
9- message in the display, and take appropriate action. Manual

The document glass or the underside of the ADF/RADF is dirty. Operation
— Clean regularly. Manual

The original is dirty or rough.
— Use a clean original.

You have not specified a suitable resolution.
— Make sure that the resolution setting in the scanner driver is appropriate for the
original.
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4 Troubleshooting

Problem

Cause and solution

Poor scanning quality.

You have not specified a suitable value for the "B/W Threshold" setting.

— If you are scanning with a TWAIN-compliant application and are using "Red", "Green"
or "Blue" mode from "Light Source" menu, make sure that a suitable value is specified
for the "B/W Threshold" setting. A larger threshold value makes your output darker,
while a small threshold value makes it lighter. To adjust the threshold automatically,
click the "Auto Threshold" button on the "Image" tab of the "Custom Settings" screen.

The brightness and contrast settings are not suitable.

— If you are scanning with a TWAIN-compliant application and the resulting image has
unsuitable brightness or contrast (for example it is too bright), click the "Auto
Brightness/Contrast Adjustment" button on the "Color" tab of the "Custom Settings"
screen. Click the "Brightness/Contrast" button to adjust the brightness and the
contrast while viewing the scanned output image on the screen. If you are scanning
with a WIA-compliant application or the "Scanner and Camera Wizard", click "Adjust
the quality of the scanned picture" or the "Custom settings" button, and adjust the
brightness and contrast in the screen that appears.

The original is not placed face up in the ADF/RADF or face down on the document

glass.
— Place the original face up in the ADF/RADF or face down on the document glass.

The original was not placed in the correct position.
— Place the original correctly.

"Quick Scan" has been selected.

— If scanning is performed when the "Quick Scan" option has been selected, image
quality may be degraded. This is because the scanned data is transferred using
JPEG compression. If image quality is poor, then perform scanning again without
selecting the "Quick Scan" option. ("Quick Scan" is not selected by default.)
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4 Troubleshooting

Problem

Unable to scan the image.

Cause and solution

If scanning is not possible, shut down your computer, turn off the machine's
power switch, and unplug the machine's power cord. Next, start your computer,
restore power to the machine, and try scanning again. If scanning is still not
possible, check the following items.

Your application is not TWAIN/WIA compliant.
— If your application is not TWAIN/WIA compliant, scanning will not be possible. Make
sure your application is TWAIN/WIA compliant.

You have not specified all scanning preferences appropriately.
— Scanning a large area in full color at high resolution results in a large amount of data
and extended scanning times. The scanning preferences should be set appropriately

for the type of original to be scanned, i.e., Web page (monitor), Photo, FAX, or OCR.

Scanner transfer speed is slow.

Your computer does not meet the system requirements for the USB 2.0 interface

(Hi-Speed mode).

— See "System requirements for USB 2.0 (Hi-Speed mode)" in the Operation Manual to
configure your system as required for USB 2.0, and then set "USB2.0 MODE
SWITCH" in the user programs to "HI-SPEED".

Operation
Manual
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TROUBLESHOOTING

If a Notice Page is printed

If you find that a notice page has been printed at the end of a print job, the print data received from the computer has not been

printed as specified.
If the following Notice Page is printed, disable the ROPM function by removing the checkmark from "ROPM" in the "Configuration”

tab of the printer driver setup screen. If you wish to use the ROPM function, set the print quality to "Draft".

st s sfe sk e sk sfe sk sk st s sfe sk sk sk sfe sk s st sk sfe sk sie s sk sk sk st s sk sk st sk sfe sk sk st sfe sk sk st s sk ke skeoskoskoskokeoskosk

Notice Page
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The IMC memory full error had occurred,
a normal output was not able to be executed.

Please refer to the operation manual for
the solution method.

Dot The IMC memory is used to store print data when the ROPM function is used. This memory is also used to store original image data
/A copy mode. The percentage of IMC memory allocated to the printer function can be adjusted on the "MEM. FOR PRINTER"

setting in the user programs (see "USER PROGRAMS" in the Operation Manual).
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PRINTER DRIVER FEATURES

Printer Driver Features

Setting Selections Initial setting

Main Copies 1to 999 1

Collate On/Off On

N-Up Printing 1-Up/2-Up/4-Up 1-Up

Border On/Off Off

Document Style*1 1-Sided/2-Sided (Book)/2-Sided (Tablet) 1-Sided

User Settings - Factory Defaults

[User Settings]

Setting Name Up to seven names, 20 characters each -
Paper A3 [Fit To Page]*?2, A4, A5, A6, B4 [Fit To Page]*2, B5, Ledger [Fit To

Paper Size Page]*?, Letter, Legal, Executive, Invoice, Foolscap, Folio, COM10, Letter™3

Monarch, DL, C5, 8K [Fit To Page]*2, 16K, Custom Paper

Fit To Page On/Off Off

Image Orientation Portrait/Landscape/Rotate 180 degrees Portrait

Paper Source Auto Select, Tray 1, Bypass Tray Auto Select

[Custom]

Width 3.87 t0 8.50 (in.)/98.3 to 215.9 (mm.) 3.87 (in.)*3

Length 5.83 to 14.00 (in.)/148.0 to 355.6 (mm.) 5.83 (in.)*3

Size inches/millimeters inches*3

*1 Only for model that support two-sided printing.
*2 Will be reduced to letter size or the specified size before printing.
*3 This initial setting may vary depending on your operating system settings. For information on each setting, see Help in the printer driver setup screen.

(continued)
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PRINTER DRIVER FEATURES

Printer Driver Features

Setting Selections Initial setting

Advanced Print Quality Draft/Normal/Photo Normal

2 Gradation Print On/Off Off

[Image Adjustment]

Brightness 0 to 100 50

Contrast 0 to 100 50
Watermarks Watermark (None)/TOP SECRET/CONFIDENTIAL/DRAFT/ORIGINAL/COPY (None)

Text - -

Size 6 to 300 200

Angle -90 to +90 +45

Gray Scale 0 to 255 192

On First Page Only On/Off Off

Input Tray Options One tray/Two trays One Tray
Configuration

ROPM On/Off On

CONTENTS
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6

For detailed information on the settings in the printer driver, Print Status Window, scanner driver, and Button Manager, see the help

files for each.

C A )

Advanced........cccccceeiieenennn. 42
Application Selection.......... 31
"Auto Scan Area Adjustment”

button ... 25
C B )
Basic Printing...........ccc......... 5
Border........ccooiiiiiiiis 9
Button Manager ................. 31

Button Manager Settings ... 32

C c )

Cancel a printjob.................. 6
"Close" button .................... 24
Configuration..........c........... 42
C D )
Document Style.................. 11
C F )
Fitto Page........cccccvvvennnnn. 10

C H )

Help
Button Manager-.............. 31
Print Status Window ....... 14
Printer driver..................... 8
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